EUCHNER

More than safety.

Setting up the EKM software as a programming station
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Components/modules used
EUCHNER

Description
EKM software

EKS USB
EKS USB driver
EKS Electronic-Key

EUCHNER

More than safety.

Order no./item designation

098578 / ANWPG ELECTRONIC KEY MANAGER, SINGLE
093322 / ANWPG ELECTRONIC KEY MANAGER

098513 / EKS-AIUXA-GO1-STO1/04
094376 / ANWPG EKS USB DRIVERS

077859 / EKS-AKIRDWT32-EU
084735 / EKS-AKIBKWT32-EU
091045 / EKS-AKIBLWT32-EU
094839 / EKS-AKIGNWT32-EU
094840 / EKS-AKIYEWT32-EU

Tip: More information and downloads about the aforementioned EUCHNER products can be found at www.EUCHNER.de. Simply

enter the order number in the search box.

Others
Description
PC

USB cable

Item

Any Windows PC that meets the requirements in the
EKM manual (093336)

Any USB cable to connect the EKS to the PC
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EUCHNER

More than safety.
Functional description

General

The software is set up as an Electronic-Key programming station on a PC, suitable for the various EKS examples. This example
also serves as the basis for EKS applications in the various control systems.

The EKM user is the person who issues Electronic-Keys in the EKM. The input screen and the database are set up for this user, so
that EKS Electronic-Keys can be administered.

Example of an Electronic-Key structure
The data on the Electronic-Key are structured as follows:

Byte no. Description Type Length Explanation

103-104 KEYCRC CRC 2 bytes Checksum over a certain part of the ElectronicKey as copy protec-
tion. Refer to the EKM manual for details about the CRC.

105-112 Expiry date Date 8 bytes Electronic-Key expiry date

113-114  Authorization level ~ Word 2bytes  Authorization level for access to the machine.

115 Department Byte 1 byte Number describing a limited quantity of machines or installations.

116 -123  KeylD KeylD 8 bytes The KeylD is a number that is permanently pre-programmed on the

Electronic-Key by EUCHNER. This number is different for each Elec-
tronic-Key. It can be used to identify workers.

This is only a very simple example. The data range on the Electronic-Key is structured according to the requirements for access to
machines or installations. Additional data, e.g. identification data or data for other areas or departments, can also be created on
the Electronic-Key. Supplementary data for which there is no memory space on the Electronic-Key can be stored in the EKM data-
base. Please refer to the application “Definition of the Electronic-Key structure on an EKS Electronic-Key” (AP000169-1-...) for
details about structuring the data range on the EKS ElectronicKey.

KEYCRC, which is used to calculate a checksum over the Electronic-Key content, is an important field for preventing the copying of
Electronic-Keys. This field should be calculated and monitored in the control system as well. This permits the creation of effective
protection against counterfeit or copied Electronic-Keys. An example for this can be found in the application AP000169-5....

Defining the Electronic-Key structure is the most important step in using the EKS. This defines the capabilities of the EKS Electron-
ic-Key.
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More than safety.
Setting up the EKM software

Creating the database
Start Design mode. It can be found in the menu Tools=>Design mode

ook | Help

T
@ Database

£8 User

EUCHNER

|E Design mode

Import...
Show import log
Q Template list

i Template

Mew template

Language

I Port COMS - |4 ekm |

Figure 1

The “Design mode” window opens. Select the “Database” menu item in [B2&=ba= | this window.

The “Database Designer” window opens. Click the “Insert” button and enter the following four lines.

= oo S
|

Figl.. & OnKey Fieldname Type StartByte  Length BitHo DisplayT... Unigue Template

1 KEYCRC CRC 105 11 103 Dez

2 ExpiringD ate Date 105 8 =] (=]}

3 AccessLevel Bute [0.. 255) 113 1 Dez [=] (=]

4 Department ‘wiord [0 .. B5535) 114 z Dez B =

5 [ |LastMame Shing 40 1} |
»E ] |FirstName Shing 40 ] =

Up BitString editor Insert ]L Delete J [ i H LCancel

Figure 2

Accept the changes with “OK”. As soon as you enter “OK” in the Database Designer, you are returned to the “Design mode”
screen.
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Creating the layout for the input screen

To do this, select the Layout Designer via the “Layout” menu ‘ Layout | option. An empty window (input window) for creating the
screen appears, as well as the “EKM-Designer” and “Alignment palette” windows.

Alignment palette i
[
| e R . JTU .4
3 =|_| 41 JJ EJ*I 1 = JJ

Figure 3

The empty window in the middle is the input window in which the actual layout for the input screen is created. The size of this win-
dow corresponds to the size of the input window visible to the EKM user. You can change the size using the mouse.
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More than safety.
Now select the “EKM Standard” tab in the “EKM-Designer” window.

EKM Datahase || ERH Standad |
h OUA@

Using the button for text input,
A

switch to input of a simple text output in the screen.
Then leftclick on the desired location for a text in the input window. A text field with the text content “cxLabell” then appears in
the input window.

Hle Edit Help
x v 74 Yy =
Cancel Apply Undo Redo
Soulzbells
al |4 ekm
Figure 4
Now change to the “EKM-Designer” window and enter the desired text under the “Caption” item.
oromer
I
EKM Database | EKM Standard
"mmgﬂm
[ Caption
Height 17
Hint
Left 40
MName cxlabeld
ShowHint
HStyle [T cuLabelEditStyle]
TabOrder 2
Tag a
Top 23
Width El
Figure 5

Tip: Under the “Name” property, enter a unique name that you can easily retrieve later when assigning the rights for EKM users.
Tip: You can match the font size, font and color to suit your requirements by opening the “Style” field in the EKM-Designer window.
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Now switch back to the EKM Database tab.

EKM Databaze | EKR Slandardl

h SR EYER

S
There, click the “cxDBDataEdit” button to input a date. Left-click in the input window and move the “cxDBDateEdit1” field to
the desired position in the input window.

,

File Edit Help
| Xy o L [
. - gn mode
Cancel Apply Undo Redo

Expiring Drate Key: kDB D ateEdit] =

al |4 ekm |
Figure 6

Now open the “DataBinding” property in the “EKM-Designer” window, so that the “DataField” property appears. Here, select the
“expiry_date” database field from the pull-down menu. This ties the content of the field in the screen to the “expiry_date” database
field. If a value is now entered, this value will appear at the predefined location of the Electronic-Key.

exu-Designe

EkM Database | EKM Standard
y mETEEeE
I

B DataBinding [TcxD BT extE ditD ataBindir
D ataField E zpiringD ate| =l
Height 4

Hint

Leit

Mame

ShowHint
M Shila

Figure 7

Now enter the other fields in the screen as well. Every field will not be described in detail below; the procedure is similar to the one
described above.

It must be possible to select the authorization level via unambiguous texts, not with numerical values. The equivalents for the texts
are stored as numerical values of the type “Byte” on the Electronic-Key. The “CXDBExComboBox” editor is therefore used for the
authorization level field. This type of editor differs from the description above and is therefore described below.
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E
Click the “cxDBExComboBox” e button in the “EKM-Designer” window.
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Then click the desired input location for the authorization level value in the input window. Then input the “Authorization level” data

field as the data binding in the “EKM-Designer” window. Then click the “...” == button in the “ltems” properties with the content

(TStrings).
EDatabBinding [TexDBT extEditD ataBindin
DataField AccessLevel
Height 24
Hint
[ Ttems =)
Left
Name Field*coess
ShawHint
Style [TexEditStyle]
TabOrder 3
Tag 3
Top il
“Wwidth 1268
Figure 8

A window opens in which texts can be entered on the left and the associated values can be entered on the right. Use the “Add”

button to create a new line in each case. You can accept all input values with the “OK” button.

[——
String List Editor e )

Description
Avtornatic:

Setting
Cleaning

Pragramming

igure 9

Once you have input all fields, your input window will look similar to this one.

Expiting date key:

Acces lewvel:

Department:

KewlD

KEYCRC:

al |4 ekm
Figure 10

o
Accept the data with the “Apply” Al button.
V

To save all changes — both the database structure and the layout data — click the “Apply” [ #ealv. button again in the following win-

dow.
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File Edt Help

4 b4 v 0

Database Layout Cancel Apply Undo

Expiring date key: |Z|
Acces level: |Z|
Department:

KeylD:

KEYCRL:

al |4 ekm
Figure 11

You will then receive a message stating that the new layout fields have not been made visible to all users yet.

40l To be ableto see new or un-named controls,
¥’ the related user rights must be assigned first.

Figure 12

This may be followed by a question about whether the new data are to be saved in the database or discarded. You must accept the

data. After acceptance of the data, Electronic-Key data saved until this point could be lost if the data structure was changed.

Warning:
On the application of the new table structure, the
existing key data for changed/deleted data fields will be lost.

-

Apply changes?

Yes

igure 13

This exits Design mode and returns you to the input screen, which is still empty. As described in the message above, the screen
does not display any of the newly entered fields because you as the user do not have the right to see or edit these fields yet.
These rights therefore have to be assigned in the next step.

Subject to technical modifications; no responsibility is accepted for the accuracy of this information. © EUCHNER 2015
AP000169-2_02_09-15 Page 9 of 12




EUCHNER

More than safety.
Creating rights for the EKM user

For this section, it is assumed that you work with the EKM login “EKM.” Menu item Tools->User takes you to the user manager, via
which access to the EKM, as well as screens and data, is administered.

Tooks i Help
@ ‘ Database [E EL':

28 User ase  Template
&% Design mode

Expiri Import... | 2016 E

Show import log

ACces|
Q Template list

B Template
D New template 1147

Language
KeylDi $3EVDFENDO3Z

KEYCRC:

Port COM5 ~[Z ekm I
Figure 13

Click the “Rights” button in the user manager.
Userr:tanager

Groups: Rights available:

- Jab Administrators = Button_D atabase_E dit -
o Zih Emlnyers == Button_Database_Visible |
= Button_Designer

= Buttan_lmpart
== Button_|mpoitLog
= Button_TemplateList
== Button_TemplateFead
= Button_Templatet/rite

= Button_Undo
= Buthon_JserM anager
o= Button_wiriteF ey
== cuDBDateEdit]_Edit
~= cxDBDateEdit]_Visible
= cxDBTextEdit1_Edi
== DB TextEdit]_Visible
~= DB TextEdit?_Visible
== cuDBTextEditd_Visble
= culabell_\isible
= cxlabel3_Visible
= culabeld Visible
= Figlddcoess_Edit

.= Fielddrrace Wishle

Cloze

igure 13

In this screen, click the option switch “Apply all rights available” and then the “Close” button.

Tip: As the user possesses EKM administrator rights, it is advisable to create at least one other user in a different group, who then
has only the rights to administer Electronic-Keys. More details about this can be found in the application APO00169-1...
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Writing the EKS Electronic-Key

All input options are now available to you in the input window. To write the first Electronic-Key, insert an Electronic-Key into the EKS.

Fle Edit Toolk Help

€ H o | m

Read Write Discard Database  [erpiEte
Expiting date key:
Acces level: E|
Department:

KeylD:

KEYCRLC:

Figure 14

To accept the input data on the Electronic-Key, click “Write” fws= . and wait until the data have been written to the Electronic-Key.

Tip: Use the TransponderCoding software to verify the content of the first Electronic-Key on the PC. In most cases, this is easier
than in a control system. The software is available from EUCHNER under the order number 067190.
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Important note - please observe carefully!

This document is intended for a design engineer who possesses the requisite knowledge in safety engineering and knows the ap-
plicable standards, e.g. through training for qualification as a safety engineer. Only with the appropriate qualification is it possible
to integrate the introduced example into a complete safety chain.

The example represents only part of a complete safety chain and does not fulfill any safety function on its own. In order to fulfill a
safety function, the energy switch-off function for the hazard location and the software within the safety evaluation must also be
considered, for example.

The introduced applications are only examples for solving certain safety tasks for protecting safety doors. The examples cannot be
comprehensive due to the application-dependent and individual protection goals within a machine/installation.

If questions concerning this example remain open, please contact us directly.

In accordance with Machinery Directive 2006/42/EC, the design engineer of a machine or installation is obligated to perform a risk
assessment and take measures to reduce the risk. When doing this, the engineer must comply with the applicable national and
international standards. Standards generally represent the current state of the art. Therefore, the design engineer should continu-
ously inform himself about changes in the standards and adapt his considerations to them. Relevant standards include EN ISO
13849 and EN 62061. This application must be regarded only as assistance for the considerations about safety measures.

The design engineer of a machine/installation is obligated to assess the safety technology itself. The examples must not be used
for assessment, because only a small excerpt of a complete safety function was considered in terms of safety engineering here.

In order to be able to use the safety switch applications correctly on safety doors, it is indispensable to observe the standards EN
ISO 13849-1, EN ISO 14119 and all relevant C-standards for the respective machine type. Under no circumstances does this doc-
ument replace the engineer’s own risk assessment, and it cannot serve as the basis for a fault assessment.

Particularly in case of fault exclusion, it must be noted that this can be performed only by the design engineer of a machine or
installation and requires a reason. General fault exclusion is not possible. More information about fault exclusion can be found in EN
ISO 13849-2.

Changes to products or within assemblies from third-party suppliers used in this example can lead to the function no longer being
ensured or the safety assessment having to be adapted. In any event, the information in the operating instructions on the part of
EUCHNER, as well as on the part of third-party suppliers, must be used as the basis before this application is integrated into an
overall safety function. If contradictions should arise between the operating instructions and this document, please contact us
directly.

Use of brand names and company names

All brand names and company names stated are the property of the related manufacturer. They are used only for the clear identifi-
cation of compatible peripheral devices and operating environments in relation to our products.

EUCHNER GmbH + Co. KG - KohlhammerstraBe 16 - 70771 Leinfelden-Echterdingen
Telephone: +49 711 75 97 -0 - Fax: +49 711 75 97 -303 - info@euchner.de - www.euchner.de
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